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Welcome to the CM-Z200

Menu map
You can easily make calls or access your phone’s settings using the Jog Dial™
navigator. Use this menu map as a guide to the features of your CM-Z200 phone.
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To scroll down:
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in some areas and with some
service providers. Check with
your service provider to see if
these features are available in
your area.

These features may not be fully
available in some countries.

This option appears when you
enter three digits or more.

This option appears when you
enter less than three digits.
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Features menu
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Before operating the CM-Z200 digital portable cellular telephone, please read this
manual thoroughly and retain it for future reference. If your usage includes in-
vehicle operation, it is recommended that you refer to the Installation/Connections /
Operation manual for the optional accessory kits.

DISPOSAL OF LITHIUM ION BATTERY
LITHIUM ION BATTERY. DISPOSE OF PROPERLY.

You can return your unwanted lithium ion batteries to your nearest Sony Service
Center or Factory Service Center.

Note: In some areas the disposal of lithium ion batteries in household or
business trash may be prohibited.

For the Sony Service Center nearest you call 1-800-222-SONY (United States only).
For the Sony Factory Service Center nearest you call 416-499-SONY (Canada only).

[ WARNING|

To prevent fire or shock hazard, do not expose the unit to rain or moisture.
To avoid electrical shock, do not open the cabinet. Refer servicing to qualified
personnel only.

FCC CAUTION STATEMENT
You are cautioned that any changes or modifications not expressly approved in this
manual could void your authority to operate this equipment.

Owner’s record

The model number, regulatory number, and serial number are located on a
nameplate inside the battery compartment. Record the serial number in the space
provided below. Refer to these numbers whenever you contact your dealer
regarding this product. You may want to record your phone’s lock code here as
well. See page 5.16 for information about lock codes.

Model No.: CM-Z200

Serial No.:

Lock code:

DIGITAL BY
XN OUALLOMM
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Rules and requlations

The U.S. Federal Communications
Commission and the Industry Canada
regulate cellular telephone service in
their respective countries. It is
important for you, the cellular
telephone user, to observe the
applicable regulations when operating
your cellular telephone in either
country. In addition to these U.S. and
Canadian federal regulations, you may
be bound also by certain state,
provincial, territorial, and local rules
and regulations, as well as by your
cellular carrier’s tariff (the rates, terms,
and conditions of its service). If you
wish to use your cellular telephone in
both the U.S. and Canada, please
consult with your System Operator.

Furthermore, you should remember
that your cellular telephone is a
radiotelephone, — i.e., it combines both
wireline technology, as used in your
home or office telephone system, and
radio technology — and that the scope
of regulations and precautions is
therefore broader than the scope of
regulations and precautions relating to
wireline-only telephone usage.

Some of the major points of
consideration are set out below. Please
note, however, that these “Rules and
Regulations” and "Safety Precautions”
sections do not constitute legal advice,
and are intended merely for general
information purposes. If you have
specific questions, please contact your
cellular carrier (System Operator).

License — If your home system is in the
U.S., you do not require a separate
license to operate your cellular
telephone; obtaining a cellular
telephone access number is sufficient to
register you as a user. If your home
system is in Canada, a separate license
is required; your carrier will assist you
in the licensing process. If you wish te
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use your cellular telephone on both
sides of the border, please contact your
cellular carrier (System Operator).

Equipment modifications — The U.S.
Federal Communications Commission
has type-approved the model of cellular
telephone which you have purchased,
and has allocated a specific frequency
range for cellular service. No changes
or adjustments are to be made to your
cellular telephone.

The radio equipment shall be made
available for inspection upon request by
representatives of the FCC or licensees.

Denial of service — A cellular carrier
may deny service temporarily or
terminate service for violation of any
government regulations or violation of
its tariff.

Privacy — As a telephone user, you
have come to assume a certain standard
of privacy when you place or receive a
telephone call via the traditional
wireline systems. However, because
cellular telephones utilize radio
transmissions to effect calls, the same
standard cannot always be assured.
While it is unlawful for any
unauthorized person to divulge or use
any information obtained from
intercepting or “listening in on”
conversations intended for others, you
should not assume that your
conversation is completely secure.
Commercially available scanning
equipment can permit a third party to
monitor the radio channels used for
cellular telephone calls.

Interference — No person shall
interfere with, or cause interference to,
any radio communication or signal.



Safety precautions

-

IMPORTANT

For safe and efficient operation of
your phone, observe these
guidelines.

" Your dual mode (analog/digital
CDMA) hand-held portable cellular
telephone uses both analog frequency
modulation (FM) technology and
digital Code Division Multiple Access
(CDMA) technology. CDMA is a newer
radio frequency (RF) technology than
the FM technology that has been used
for radio communications for decades.

Your dual mode portable cellular
telephone is a radio transmitter and
receiver. When the phone is ON, it
receives and sends out radio frequency
(RF) energy. The phone operates in the
frequency range of 824 MHz to 894
MHz. When you use your phone, the
cellular system handling your call
controls the mode of operation (analog
or digital CDMA) and the power level
at which your phone transmits. In the
analog mode, the power is continuously
transmitted at a level that can range
from about 6 mW to about 600 mW. In
the digital COMA mode, the power is
transmitted as a digitally coded
waveform at a rate varying from 100 Hz
to 800 Hz. The average power can range
from about 0.01 pW to about 200 mW.

Exposure to radio frequency
energy

Research on health effects from RF
energy has focused for many years on
FM radio technology. That research and
studies regarding newer radio
technologies, such as CDMA, have
found no credible scientific evidence
that adverse health effects result from
the use of cellular telephones.

The Institute of Electrical and
Electronics Engineers (IEEE) in 1991,
and The American National Standards
Institute (ANSI) in 1992, updated the
1982 ANSI Standard for safety levels
with respect to human exposure to RF
energy. Over 120 scientists, engineers,
and physicians from universities,
government health agencies, and
industry, reviewed the available
research and developed this updated
Standard. In March 1993, the U.S.
Federal Communications Commission
(FCCQ) proposed the adoption of this
updated Standard.

The design of your phone complies
with this updated Standard. Of course,
if you want to limit RF exposure even
further than the updated ANSI
Standard, you may choose to control
the duration of your calls and operate
your phone in the most power efficient
manner.

Efficient phone operation

For your phone to operate at the lowest
power level consistent with satisfactory
call quality, please observe the
following guidelines:

Your phone has an extendable antenna;
extend it fully whenever possible for
maximum efficiency.

Hold the phone as you would any other
telephone. While speaking directly into
the mouthpiece, position the antenna
up and over your shoulder.

Do not hold the antenna when the
phone is in use. Holding the antenna
affects call quality and may cause the
phone to operate at a higher power
level than needed.
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Antenna care and replacement
Do not use the phone with a damaged
antenna. If a damaged antenna comes
into contact with the skin, a minor burn
may result. Replace a damaged antenna
immediately. Take your phone to an
authorized service center for repair.

Use only the supplied or approved
antenna. Unauthorized antennas,
modifications, or attachments could
impair call quality, damage the phone,
and violate FCC regulations.

Driving

Check the laws and regulations on the

use of cellular telephones in the areas

where you drive. Always obey them.

Also, when using your phone while

driving, please:

* pay full attention to driving;

* use hands-free operation, if available;

¢ pull off the road and park before
making or answering a call, if driving
conditions so require.

Electronic devices

Most modern electronic equipment is
shielded from RF energy. However, RF
energy from cellular telephones may
affect some electronic equipment.

RF energy may affect improperly
installed or inadequately shielded
electronic operating and entertainment
systems in motor vehicles. Check with
the manufacturer or its representative
to determine if these systems are
adequately shielded from external RF
energy. You should also check with the
manufacturer of any equipment that
has been added to your vehicle.
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Medical devices

Consult the manufacturer of any
personal medical devices (such as
pacemakers, hearing aids, etc.) to
determine if they are adequately
shielded from external RF energy. Your
physician may be able to assist you in
obtaining this information.

Turn your phone OFF in health care
facilities when regulations posted in the
areas instruct you to do so. Hospitals or
health care facilities may be using
equipment that could be sensitive to
external RF energy.

Aircraft

Turn your phone OFF before boarding

any aircraft.

¢ Use it on the ground only with crew
permission.

¢ Do not use in the air.

To prevent possible interference with
aircraft systems, U.S. Federal Aviation
Administration (FAA) regulations
require you to have permission from a
crew member to use your phone while
the plane is on the ground. To prevent
interference with aircraft
communication systems, FCC
regulations prohibit using your phone
while the plane is in the air.

Children

Do not allow children to play with your
phone. It is not a toy. Children could
hurt themselves or others (by poking
themselves or others in the eye with the
antenna, for example). Children also
could damage the phone or make calls
that increase your telephone bill.



Blasting areas

To avoid interfering with blasting
operations, turn your unit OFF when in
a “blasting area” or in areas posted:
“Turn off two-way radio.” Construction
crews often use remote control RF

- devices to set off explosives.

Potentially explosive
atmospheres

Turn your phone OFF when in any area
with a potentially explosive
atmosphere. It is rare, but your phone
or its accessories could generate sparks.
Sparks in such areas could cause an
explosion or fire resulting in bodily
injury or even death.

Areas with a potentially explosive
atmosphere are often, but not always,
clearly marked. They include fueling
areas such as gas stations; below deck
on boats; fuel or chemical transfer or
storage facilities; areas where the air
contains chemicals or particles, such as
grain, dust, or metal powders; and any
other area where you would normally
be advised to turn off your vehicle’s
engine.

Do not transport or store flammable
gas, liquid, or explosives in the
compartment of your vehicle which
contains your phone or accessories.

In the United States, vehicles using
liquefied petroleum gas (such as
propane or butane) must comply with
the National Fire Protection Standard
(NFPA-58). For a copy of this standard,
contact the National Fire Protection
Association, One Batterymarch Park,
Quincy, MA 02269, Attn: Publication
Sales Division.

In Canada, vehicles using liquetied
petroleum gas (such as propane or
butane) must comply with the
Canadian Gas Association (CAN/CGS-
B149.2). For a copy of this standard,
contact the Canadian Standards
Association, 178 Rexdale Blvd.,
Etobicoke, ON M9W 1R3, Attn.:
Standard Sales Department.

Heat and sunlight exposure
Avoid leaving your phone exposed to
direct sunlight or extreme heat.
Extended exposure to heat and /or
sunlight may damage your phone.
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Unpacking your phone

.

Carefully unpack your phone and check the contents using this list.
If there is something missing, please contact your nearest Sony dealer.

Additional accessories and different AC adapters may be supplied with phones

outside North America. See “Accessories” on page 6.2 for more information about
accessories.

CM-Z200 Telephone (1)

QN-029BPL Li-lon Battery (1)

Hand Strap (1)

Attaching the hand strap

2.1
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Looking at your phone

For further information, refer to the page numbers indicated in parentheses ().

T—fe—=_
7
15
o=
o
S=clS
@ .
Telephone
Cali alert indicator (3.1, 3.3) button (3.2)
Lights when there is an incoming call. Press to end calls. Also cancels
, operations and returns the phone to
Earpiece standby mode.
Display (2.3) (9] @® (power) button (3.1)
[4] Number buttons and @o)/&> Press to turn the phone on or off.

buttons (3.2, 4.1, 4.2)

Use the number buttons to enter letters
and numbers. Press and hold a number
button for touch dialing. Use the G/ Hand strap attachment (2.1)
buttons to move the cursor when

Ringer speaker
Allows ringer sounds to be heard.

you are entering letters. Battery (2.4)

(5] Folding microphone arm Batﬁery release tab (2.4)
Open to make/ receive a call. Push up to remove the battery.
Close to end a call. Antenna (3.1)

{6] button (3.2, 4.6, 4.10) fi§ Jog Dial™ navigator (1.2)
Press to make outgoing calls and to Push and turn for menu navigation and
receive incoming calls when the for changing settings on menus.
microphone arm is open.

Connector (2.5)

(clear) button (3.2, 3.3) Use to connect the phone to either the
Press to clear the last digit on the AC adapter or to one of the other
display, or to exit the current mode of accessories available for your phone.

operation. Press and hold to clear a]l
digits on the display.
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Display
The top row of the display contains icons that inform you of the current status of

your phone. The bottom four rows of the display are for text such as phone numbers,
names, and operational prompts. Each row displays up to 12 characters.
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I
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2/

[1] short character display
Shows settings such as the number of
the currently displayed Menu, as well
as Phone Book and Calls List memory

(5] @ (roam) icon (5.22)
Appears when you are roaming
outside your home service area.

locations. [6] [ (message) icon (5.2)
Appears when you have new text or
¢ (in-use) / ¥ (out-of-service) icon voice mail messages pending. The icon
(3.1t0 3.3) B e §
.1to 3.

flashes if the new message is urgent.
The in-use icon appears during a call.

A slash through the in-use icon <zrll (battery) icon (2.5, 2.6)

Getting Started

appears when no signal is received.
You cannot make or receive calls when
the out-of-service icon is visible.

[ (digital) icon
Appears when your phone is receiving
a digital signal.

(4] Yull (signal strength) icon (3.1)
Tells you the approximate strength of
the signal being received.

Shows the approximate amount of
charge power remaining in the battery.
Recharge the battery before it is fully
discharged.

Character display

Shows phone numbers, names, menus
and other phone information.
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Charging the battery

Charge the battery before using the phone. A new battery is not fully charged. To
charge the battery, attach it to the phone, then connect the supplied AC adapter.

Attaching the battery

1 Hook the battery onto the top of the phone @),
and ease the battery down @.

2 Snap the battery in place.

To remove the battery

1 Push the battery release tab upwards.

2 Lift up the bottom of the battery (),
and pull it out @.
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Charging the battery

You can charge the battery using the QN-001AC AC adapter that is supplied with
some phones. You may also use one of the accessories listed on page 6.3 to charge
your battery.

Connect the AC adapter to the phone and the other end to a standard AC outlet as
illustrated below. The charging time is approximately 3.5 hours. You can charge the
battery with the phone turned on, but charging will take longer.

toan AC wg

outlet

to the connector on the phone (the
thumb indent should face upwards)

When the power is turned on
As the battery charges, the battery icon (@) pulses to indicate that the phone is
charging.

When the power is turned off

The message Battery is Charging is displayed, and 52 pulses. When the battery
is fully charged, the message Charging is Complete is displayed, and & stops
pulsing.

* If you make or receive a call when the battery is not charged sufficiently, the call will be
cut off. In that case, you will hear an alert, indicating that the battery is low.

¢ You can turn on the phone without the battery, but you cannot make or receive a call,
even if you connect the AC adapter to an AC outlet.

Notes on charging
¢ When you charge the battery, avoid:
- charging for long periods of time, since this reduces battery life.
- charging in temperatures below 32°F (0°C) or over 104°F (40°C).
- charging the battery in direct sunlight or in places with high humidity (such as
a bathroom).
¢ Do not use any battery other than the one specified in these instructions.
* It is normal for the battery to become warm during charging or after use.
* The supplied AC adapter is not intended to be serviced. In the event of a
malfunction, it should be replaced. .
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Battery precautions

* Do not expose the battery to temperatures above 140°F (60°C). For example, do
not leave the battery in the sun on the dashboard of a vehicle.

* Do not dispose of the battery in a fire or short-circuit it. Doing so may cause the
battery to leak or get hot, which could cause personal injury.

* Do not try to disassemble the battery.

Checking the battery

Battery life
The battery lasts approximately as long as indicated in the following table before it
needs to be recharged. Battery life may vary depending on conditions of use.

Digital mode Analog mode
Standby time 45 hours 11 hours
Talk time 2.3 hours 1 hour

Battery condition
The battery icon indicates the battery level as follows (when the power is on):

NV

rull (o2 ~ (o) ~ )~ ) - ] *2/4_1\1 Empty
JAR I

Note that the battery icon displays the approximate charge level and that the
consumption may vary depending on conditions of use, such as ambient
temperature, network coverage, and usage patterns.

When the battery is empty

The battery icon flashes and a warning message is displayed. A beep sounds,
indicating that the battery is low. Shortly thereafter, the phone turns off. Recharge
the battery as soon as possible.
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Turning the phone on

It is preferable to extend the antenna, since this

To use your phone, the power must be turned on. U
maximizes signal strength and minimizes interference.

Extending the antenna
Hold the end of the antenna and
pull up until fully extended.

To retract the antenna -
Push the antenna down until it is fully retracted.

Turning the power on

Hold down until the phone displays POWERING ON. The call alert indicator turns
on and then off, a beep sounds, and the phone starts searching for a signal. When
the phone has found a service signal, the standby display appears. Now the phone is
ready for use.

To check the digital service

The digital service icon (B) appears when your phone is operating in digital mode. If
a digital signal is not available, your phone will look for an analog signal. Some
networks may allow you to force your phone to operate in analog mode (see
“Forcing the phone into analog mode” on page 5.25).

To check the signal strength
The signal strength icon indicates various levels of signal strength. It is best to make
calls when the signal is strong, although calls can be made when the signal strength

is weak.
Strong Y“" Yll Yll Y Y Weak

If you are out of the service area

The out-of-service icon () appears, and the phone searches for a service signal. If a
signal cannot be found, the phone enters power save mode. It will “wake up”
periodically to search for a service signal.

Turning the power off
Hold down until the phone displays POWERING OFF.

3.1
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Making calls

You can call any number up to 32 digits from within a Mic arm
service area. The out-of-service icon (&) indicates that
vou arc outside the service area.

1 Use the number buttons to enter the number.
If you enter the wrong digit, press to back up. To clear all entered
digits, press or hold down to return to the standby display.

2 if the microphone arm is closed, open it to dial. if the microphone
arm is open, press to dial.
The phone dials the number you have entered. The ¢* icon appears.
When the call is connected, the call timer appears and displays the elapsed
time.

3 Press or close the microphone arm to end the call when you are
finished.
The ¢ icon disappears and the final elapsed call time flashes for 10 seconds.
The standby display automatically reappears.

Tips

¢ When dialing, you can insert a pause to attach a DTMF (Dual Tone Multiple Frequency)
number to the number you are calling (see pages 4.2 and 4.11).

¢ If Auto-Hyphen is turned on, the phone number is hyphenated automatically as you
enter the digits (see page 5.20).

¢ If Minute Alert is turned on, a beep sounds at intervals (based on the setting you select)
throughout the call (see page 5.11).

To adjust the earpiece volume during a call

To increase the volume, turn @ up.

Turn @ down to decrease the volume.

Tip

In addition, you can adjust the volume using the Sounds menu (see page 5.8).

To mute/unmute the microphone during a call

Push and hold .

Tip

In addition, you can mute the microphone using the Sounds menu (see page 5.7).

To redial the last number
On the standby display, press when the microphone arm is open. The number
you dialed last is redialed automatically.
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Receiving calls

You can receive calls as long as the out-of-service icon
) is not displayed. The ¥ icon indicates that you
are outside the service area.

When you receive a call, the ringer sounds or the phone vibrates. Incoming Cal
flashes on the display, and the call alert indicator blinks.

1

1 If the microphone arm is closed, open it to answer the call. If the
microphone arm is open, press any button except to answer

the call.

When the call is connected, the call timer appears and displays the elapsed

time.

2 Press or close the microphone arm to end the call when you are

finished.

The ¢ icon disappears, and the final elapsed call time flashes for 10 seconds.

The standby display automatically reappears.

Tips

* While the phone is ringing, turn @ down to mute the ringer.

* Using the Jog Dial navigator, you can adjust the earpiece volume or mute the
microphone during a call (see pages 5.7 and 5.8).

* If you turn off the ringer volume (see page 5.7), you will not hear the ringer sound. The

message -Ringer Off- is displayed on the standby display.

If the caller supports caller ID

The caller’s phone number appears on the display when you receive a call if both

the caller and the carrier support this feature.

If the caller supports caller ID and the number matches a Phone Book entry, the
name that you stored with the number (if any) is displayed also.

If you miss a call

If you miss an incoming call, the message You have missed XX calls. appears on the
display. To return to the standby display, either press G, (&0), or ﬂ If the caller

supported caller ID, the caller’s number is stored in the Calls List (see page 4.10).

3.3
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Storing phone numbers in the Phone Book

Your phone features a built-in Phone Book memory,
in which you can store up to 99 (01-99) phone
numbers with names. Each phone number can
contain up to 32 digits, and each name up to 12
characters. This section shows how to store, edit, and
-erase Phone Book numbers quickly. You can dial
stored numbers quickly by recalling them from the
Phone Book (see page 4.9).

Saving a phone number (Save)

1 On the standby display, use the number buttons to enter the number.
The number appears on the display. In addition, you can store hyphens,
pauses, and links with your Phone Book entries (see page 4.2).

2 push .

The Options menu appears.

3 Turn & to select Save, then push .
The message Enter aName appears on the display, asking you for a name to
accompany the number.

4 Use the number buttons to enter the name.
If you press the same button in quick succession, you will scroll through the
characters available on that button. (See the “Alphanumeric table” on page
4.2.) For the next entry, wait until the cursor moves one step to the right or
use @G0/ &> or @ to move the cursor and insert spaces between characters.
If you enter the wrong character, press to clear the character highlighted
by the cursor.

To enter “SONY"”

Press four times to enter an “S.”

Press @) three times to enter an “O.” Wait until the cursor moves one step to the
right for the next entry.

Press @& twice to enter an “N.”

Press @) three times to enter a “Y.”

5 When you are finished, push ﬁ to store the phone number and name.
The message Save in location XX? appears on the display, indicating the
first available memory location.

6 Push ¢ to store the new number in the first available memory location.
If you want to store it in another location, turn {§ to select the
desired location or enter the location number, then push ﬂ . A confirmation
message appears, followed by the status of the Phone Book.

4.1
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Alphanumeric table (English)

Each time you press a number button, the letters/numbers appear as follows:

Button Sequence

(D) -0, & ()
eI A B C ab 2
[€ID) D E F d f 3

G H I g hi 4

(€D J KL jk1S5

&> M N O mmno 6

P QRSpgqrs 7
T UV tuwv 38

W XY Zwxyz9
[(ZD) 0

Tip

When you change your phone’s language setting (see page 5.20), a different set of
characters becomes available. See the Spanish, Portuguese or French operating
instructions (not available in all areas) to view the alphanumeric table of each language.

To enter a hyphen, pause, or link

In addition to digits, you can insert hyphens, time pauses, hard pauses, and links
into the phone number of a Phone Book entry. (See page 4.6 for information on
releasing a pause or link during a call.)

Hyphens: When you enter a hyphen manually (for example, when you want to store
a number that does not follow the US/Canada standard), autohyphenation is turned
off for that number.

Pauses: A time pause (lll) automatically sends additional digits about two seconds
after a call is connected. A hard pause ([l) allows you to send additional digits after
a call is connected. For example, you may want to enter a phone number in your
Phone Book as follows: 1-800-555-1212[§1123. The hard pause character in the phone
number allows you to dial the extension 123 after you have reached 1-800-555-1212.

Links: You can join two or more Phone Book entries (for example, a doctor’s phone
number and your medical record number). Once you have specified the first entry,
you insert a link ([M). Then you specify the second number by entering its memory
location number.

1 While entering digits, push .
The Options menu appears on the display.

2 Turn @ to select which information to enter, then push ﬂ
After inserting a hyphen, pause, or link, the display returns to number entry
mode.
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To enter Select The display shows
a hard pause Hard Pause [H]
a time pause Time Pause
a link Enter Link
a hyphen Enter Hyphen -

If the Phone Book is full

If there are no memory locations available, a message indicates that the memory is
full. After entering a name, a message prompts you to specify a memory slot to
overwrite. To cancel, press @®.

Editing stored information (Edit)
You can edit the name, phone number, and memory location of specific entries
stored in the Phone Book.

1 On the standby display, turn @ down twice to select Phone Book.
The first Phone Book entry is displayed.

2 Turn @ to select the entry that contains the information you want
to edit.
The contents of the selected memory location are displayed.

3 Push .

The Options menu appears.

4 Turn { to select Edit, then push &.
The Edit menu appears.

5 Turn @ to select the item you want to edit, then push .
The stored information that corresponds to the selected item appears.

To change Select
the name Name

the phone number Phone #
the memory location Location #

6 Enter the new information.
Enter new information the same way you stored original information (sce
page 4.1). The old information is overwritten.

7 When you are finished, push ﬁ

A message confirms that your changes have been saved.
Tip

In addition, you can use the Directory menu ta.edit Phone Book numbers (see page 5.12).
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Erasing a phone number (Erase)
You can erase stored Phone Book entries. If the selected entry is restricted, you must
enter the four-digit lock code before you can erase it (see page 5.16).

1 On the standby display, turn @ down twice to select Phone Book.
The first Phone Book entry is displayed.

2 Turn @ to find the Phone Book entry you want to erase.
The contents of the selected memory location are displayed.

3 push .
The Options menu appears.

4 Turn & to select Erase, then push & .

A message appears, prompting you to confirm the erasure.

5 push & again.
The selected entry is erased.
Tips
* You can also use the Directory menu to erase Phone Book entries (see page 5.12).
¢ Use the Security menu to erase all Phone Book entries at once (see page 5.17).

Restricting Phone Book entries (Restrict)

You can restrict individual Phone Book entries so that access can be gained only by

entering a lock code (see page 5.16). The phone numbers of restricted entries will not

be displayed. For information on restricting all Phone Book entries, see “Restricting

all Phone Book entries” on page 5.17.

1 Select the Phone Book entry that you want to restrict, then push ﬁ
The Options menu appears.

2 Turn & to select Restrict, then push .
The selected entry is displayed.

3 Push ﬁ to restrict the selected entry.
Now the selected entry is restricted.

* The phone number of a restricted entry will only be displayed after entering the lock code.
* Restricted entries are not listed when you search for Phone Book entries by phone number.
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To unrestrict an entry

1 Select the Phone Book entry that you want to unrestrict.
The message <number is restricted> indicates a restricted entry.

2 Push .

The Options menu appears.

3 Turn & to select Restrict, then push & .

A message appears, prompting you to enter the lock code. (See page 5.16 for
information on lock codes.)

4 Use the number buttons to enter the lock code.
Now the selected entry is unrestricted.

Tip
You can also use the Security menu to restrict/unrestrict Phone Book entries (see page 5.17).
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Calling from the Phone Book

You can dial frequently used numbers quickly from Mic arm
the Phone Book using the Jog Dial navigator. Also, by @—q
using speed/touch dialing, you only need to press a

few buttons to dial.

1 On the standby display, turn @ once.
The Saved #s display appears.

2 Turn & down to select Phone Book.
The first entry in the Phone Book appears.

3 Turn @ to select the desired Phone Book entry.
The contents of the selected entry are displayed.

4 Open the microphone arm if it is closed. If the microphone arm is
open, push ﬂ twice or press (sen).
The phone dials the number stored in the selected Phone Book entry. The ¢
icon appears.

Tips

* You can search for a phone number by name or memory location (see pages 4.8 and 4.9).

* Whenever the phone number is displayed, you can call it by pushing ﬁ or or by
opening the microphone arm.

* If the phone number of a selected Phone Book entry is too long to fit on the screen, you
can still view the overflow digits by selecting Ulew Number on the Options menu.

To release a pause or link during a call

If a Phone Book entry contains hard pauses or links, only the digits up to the first
hard pause or link are dialed. To dial the rest of the selected entry (and release the
pause or link), push ﬁ For a time pause, wait two seconds. The phone dials the rest
of the entry automatically. (See page 4.2 for additional information on pauses and
links.)
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Adding a prefix to a phone number (Prefix)
You can use the Prefix feature to add a prefix to a phone number before dialing. For
example, you can add an area code to an entry saved as a local phone number before
you dial.
1 On the Phone Book display, turn @ to select the desired entry.

The contents of the selected entry are displayed.

2 push .

The Options menu appears.
3 Turn { to select Prefix and push .

4 Use the number buttons to enter the prefix number you want to
add to the Phone Book entry.

5 Push § to make a call.

Speed dialing
To dial quickly, you can enter the Phone Book memory location numbers. The
phone calls the number stored in the corresponding location.

1 Use the number buttons to enter the memory location number.

2 To dial the number, open the microphone arm. if the microphone
arm is already open, press (S0).
The phone dials the number that corresponds to the memory location you
entered.

Touch dialing

You can dial a phone number stored in the Phone Book without pressing (SEND).
Before using this feature, make sure that Touch Dial on the Extras menu is set to 0N
(see page 5.14).

1 Open the microphone arm.
2 Enter the memory location number using the number buttons.

3 Hold down the last digit of the memory location number for about
one second.
The phone dials the number that corresponds to the memory location you
have entered.
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Searching the Phone Book

To locate a desired Phone Book entry, you can search
by name, phone number, or memory location. You
can search the Phone Book either alphabetically or for
a string of characters.

Searching for a name (Find Name)
You can search the Phone Book by the first letter of the entry, or by the first few
letters of a word. For example, you can search for “Bob Smith” by entering either
“B” or “Sm”.
1 From the standby display, turn @ once.

The Saved #s display appears.

2 push if.
The Search display appears.

3 Use the number buttons to enter the first letter of the entry you
want to find, or enter at least the first two letters of a word in that
entry.

4 Push ﬂ

All Phone Book entries that match your search are displayed.
5 Turn @ to view all the entries from your search.
Tip
In addition, you can use the Directory menu to search the Phone Book by name (see
page 5.12).
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Searching by memory location (Recall Loc#)
The phone searches for a memory location that matches the entered digit(s), and
displays a list of options.

1 On the standby display, enter the memory location (a maximum of
two digits).

2 Push .

The Options menu appears.

3 Turn @ up to select Recall LocHl, then push ﬁ
The Phone Book entry stored in the selected memory location is displayed.
If the entered location is empty, this is indicated on the display.
Tip
You can also use the Directory menu to search the Phone Book by memory location (see
page 5.13).

Searching for a phone number (Find Number)
The phone lists all entries that contain the entered digit(s).

1 On the standby display, enter at least three digits of the phone
number you want to find.

2 push .

The Options menu appears.

3 Turn @ up to select Find Number, then push ﬁ .
The Phone Book lists and displays all entries matching the entered digits.
Depending on the Sort Book setting (see page 5.20), the entries are listed
either alphabetically or by memory location.

4 Turn @ to view a list of entries that contain the numbers you
entered.
If a matching Phone Book entry is not found, this is indicated on the display.
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Calling from the Calls List

Information on the ten most recent outgoing calls,
incoming calls, scratch pad entries, and missed calls
are stored in the phone’s Calls List. If you call the
same number twice in a row, only the most recent call
is stored in the Calls List.

1 On the standby display, turn @ once.
The Saved #s display appears.

2 Turn @ up to go to Callslist.

Information on the most recent call appears.

3 Turn { to select the entry you want.
The contents of the selected entry are displayed.

4 Open the microphone arm if it is closed. If the microphone arm is
open, push ﬁ twice or press (G0,
The phone dials the selected Calls List entry. The ¢ icon appears.
Tip
If the selected entry contains a pause or a link, only the digits up to the pause or link are
dialed. To release pauses and links, see page 4.6.

To view detailed information of Calls List entries

In addition, you can view the digits of a phone number that do not fit on the screen,
the duration of the call, or the time and date of the call by using the Options menu in
step 4 above.

To view Select

digits that do not fit on the screen View Number
the duration of the call Duration

the time and date of the call Time/Date

To save the number to the Phone Book
Select Save from the Options menu (step 4 above) by pushing the Jog Dial
navigator.
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Sending DTMF signals from the Phone Book

You can send DTMF (Dual Tone Multiple Frequency)
signals to access electronic services (such as telephone
banking) when dialing numbers from the Phone Book.

Dual Tone Multiple Frequency is also known as “touch-tone.” A tone is generated

when you press a telephone button (number, *, or #). It can be used to access

answering machines, pagers, telephone banking services, data services, and other

electronic services.

1 During a call, search for the Phone Book entry that contains the

numbers you want to send.

The selected entry is displayed. Use the Directory menu to search for the

Phone Book entry (see pages 5.12 and 5.13).
2 push i .

The Options menu appears.

3 Turn @ to select Number Tone, then push ﬁ
A DTMEF signal, containing the entered digits, is sent in a burst.

Tips
* You can send a DTMF signal only during a call.

« To enter and send numbers one by one during a call, use the number buttons to send the

DTMF number.

* To change the length of the DTMF transmission, see “Setting the keybeep length” on

page 5.9.
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About the Features menu

>

You can use the Features menu to activate the special features of your phone. For a
list of submenus and settings, see “List of menu items” on page 6.5 or “Menu map”
on page 1.2. Several features on the Features menu are dependent on your service
provider and the network your phone is operating on. Network-dependent features
are marked with asterisks (*) on pages 1.2-1.3 and pages 6.5-6.6. Check with your
service provider to see if these features are available in your area.

Navigating the Features menu

See “Menu map” on pages 1.2-1.3 for basic information on how to navigate the
various Features menus. For more detailed information on each menu item, see the
section on that feature in the pages that follow.

To exit from the Features menu
Press or hold down to return to the standby display.

To return to the previous display
Press @D. To go back further, press again.

Tips

¢ [f you reach the last menu item and try to turn @ further, a beep indicates that you
have reached the end of the menu. To view other menu items, turn @ in the opposite
direction.

¢ The standby display automatically reappears after approximately 30 seconds of
inactivity.

» Each menu item can be accessed quickly from the standby display by pushing § and
then pushing the number of the menu item. The item number then appears in the upper
left corner of the display. For example, you can access the backlight setting by pushing
ﬂ followed by and @=).
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Checking messages (Message)

This section contains information on the Short
Messaging Service (SMS). This feature may allow you
to receive voice or text messages.

Contact your service provider to see if this service is
available in your area.

Receiving messages

To receive messages, the phone must be turned on. The phone supports three types
of messages: MESSAGE indicates a text message; PAGE typically contains only digits;

UOICE MAIL is a voice mail notification, and indicates the number of new voice mail
messages stored in your voice mailbox.

When you receive a message

The message icon (&) appears on the display and the call alert indicator flashes,
accompanied by audible alerts. The first line indicates message type and priority. If
the message is urgent, the message type is surrounded by asterisks (*) and followed
by an exclamation mark (!). If you press any key, this display disappears. The
message icon (&) remains displayed as long as there are unread messages.

Tips

 If you receive duplicate messages, the phone deletes the older one and stores the new
one with the indication DUPLICATE.

¢ [f the ringer volume is set to vibration, the phone emits a vibration instead of an
audible ring when you receive a message.

Checking message storage capacity

Voice mail messages

Voice mail messages are stored remotely by your service provider. Your phone wili
simply notify you if you have any voice mail messages. Check with your service
provider to find out the maximum number and length of voice mail messages that
can be stored.

Text messages and pages

A text message must contain at least one character, and can be up to 200 characters
long. The number of messages that can be stored depends on the size of the
messages. You can store approximately 12 large messages or 45 small messages.

[ WARNING]

When you receive a new message and your phone does not have enough memory to stor:
it, the phone erases old messages that are not locked.
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if the memory becomes full

The phone issues a warning when the memory is almost full. At this point, you
should erase expendable messages (see page 5.6).

If the memory becomes completely full or your phone does not have enough
memory to receive an incoming message, new messages are rejected.

Accessing messages

1 Push K twice from the standby display.
The Message menu appears, indicating the number of the following types of
messages, respectively:
* Voice mail messages (see below).
» Unread text messages and pages (see page 5.4).
» Text messages and pages that you have already read but are still stored in
memory (see page 5.4).

Reading voice mail message notifications [F11]

Contact your service provider to find out how to listen to your voice mail messages,
if this service is available. You may be able to view information about any voice mail
messages you have received, such as the caller’s phone number.

1 Push ﬁ to select Uoice from the Message menu.
The Voice display appears, indicating the number of voice messages stored
in your voice mailbox. Press to go back to the Message menu.

2 Turn @ to scroll through the voice mail message notification.

To dial a callback number
If a voice mail message notification contains a callback number, you can quickly
return that call.

1 After reading a voice mail message notification, open the
microphone arm if it is closed. If the microphone arm is open, push
ﬂ to see the Options menu.

2 Push ﬁ again to dial the callback phone number.
The phone dials the callback phone number which is attached to the
message.
Tip
In addition, you can dial the callback number by pressing from the Messages display
or when reading a voice mail notification message if the microphone arm is open.
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To erase a voice mail message notification

1 After reading a voice mail message notification, push ﬁ
The Options menu appears.

2 Turn @ to select Erase Msg, then push ﬁ
The voice mail notification message is erased. The Message menu reappears
indicating that there are currently no voice mail notification messages storec
in memory.

Reading new text messages [F12]

You may be able to read text messages received by your phone. Check with your
service provider to see if this service is available. Urgent messages are listed above
non-urgent ones, with the most recent entries first. After you view a new text
message, it is saved as an old text message. You can protect or erase messages using
the Old Text Messages menu.

1 Turn @ to select New Text from the Message menu, then push ﬁ
The first message is displayed. An asterisk (*) indicates an urgent message.

If there are no new messages, this is indicated on the display. Push ﬁ to
return to the Message menu.

2 Turn @ to scroll through the message.
If you do not scroll, the display automatically scrolls down.

3 While viewing a message, push ﬁ to go to the next text message.
The Options menu appears. To return to the standby display, press &2).

4 Turn @ to select Next Msg, then push ﬁ
The next message is displayed. If there are no more messages, the Message
menu reappears.

When you have finished viewing a new text message, it is stored as an old text message.

Reading old text messages [F13]
The most recent messages are listed first.

1 Turn @ to select 01d Text from the Message menu, then push ﬂ
A list of old messages is displayed. A dot (#) indicates the beginning of eac!
message. A lock icon () indicates that the message is locked (see page 5.5).
If a number is too long to fit, an ellipsis (...) is used.
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2 Turn @ to scroll through the list of old messages.

3 To read the selected message, push .
The selected message is displayed.

4 Turn @ to scroll through the message.
If you do not scroll, the display automatically scrolls down to the end of the
message.

5 When you have read the message, press to return to the list of
old messages.
To read the next message, push ﬁ to go to the Options menu, then
select Next Mss. To read the previous message, push ﬂ to go to the
Options menu, then select Prev Msg.

To protect a text message
You can lock a message to protect it from being erased.

1 After reading a message, push ﬂ
The Options menu appears.

2 Turn & to select Lock Msg, then push #].
A message indicates that the message is now locked.

The phone does not erase locked messages automatically. When there is not enough
memory for incoming messages, you must erase the locked messages manually.

To respond to a text message

1 After reading a text message, open the microphone arm if it is
closed.

2 If the microphone arm is open, push ﬁ to see the Options menu.
Turn & to select Send, then push & .

- The phone dials the callback phone number which is attached to the
message. If a callback number is not attached to the message, no call is made
and a message indicates that a callback number is not available.

Tip

In addition, when viewing a text message or the list of old messages, you can dial the

caliback phone number simply by opening the microphone arm, or pressing when the
microphone arm is aiready open.
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To save the callback number

1 After reading a message, push ﬂ
The Options menu appears.

2 Turn @ to select Save Number, then push ﬁ
A message appears, prompting you for a name to accompany the number.

3 Use the number buttons to enter the name.
See the “Alphanumeric table” on page 4.2 for information about entering
characters.

4 Push §f to store the phone number and name.
A confirmation message appears.

5 Push i to store the new number in the first available memory
location.
If you want to store it in another location, turn @ to select the desired
location, then push ﬁ

To erase a text message

1 After reading a text message, push ﬁ .
The Options menu appears.

2 Turn & to select Erase Mss, then push .
The message is erased.

Erasing old text messages [F14]

1 Turn @ down to select Erase 0ld from the Message menu,
then push .
The Erase Old menu appears.

2 Press (D to erase old messages.
All unlocked old messages are erased. To go back to the Message menu
without erasing the messages, push ﬁ If you erase all old messages, it w:
be indicated on the Message menu.

Tip
To erase a locked message, select Erase Msg from the Options menu of that message.
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Adjusting the volume (Sounds)

You can adjust the volume of the ringer, keybeep, and earpiece on the Sounds menu.
You can select the type of sounds heard when the phone rings and when you press
buttons. You can also select to have vibration alert instead of a ringing sound.

Adjusting the ringer volume [F21]

1 Push i to select Ringer Uol from the Sounds menu.
The Ringer Vol. menu appears.

2 Turn @ up to raise the ringer volume, and down to lower it.
You can select from six ringer volume settings: off, low, med. (medium),
hish, escalate, and vibration.

3 Push i to enter the new setting.

If you turn off the ringer volume

The message —Rinser Off- is displayed at the top of the screen when the standby

display appears.

Tips

* While the phone is ringing, turn @ down to lower the ringer volume for that call.

* If you set the ringer volume to escalate, the telephone rings twice at a low volume,
then once at medium volume, and thereafter at a high volume.

¢ If you set the ringer volume to vibration, the telephone emits a vibration instead of an
audible ring.

¢ If the telephone is used with a hands-free car kit or charging accessory, the vibration
setting is not available.

Muting/unmuting the microphone [F22]

You can mute/unmute the phone during a call directly, without using the Sounds
menu by pushing and holding ﬂ . In addition, you can mute/unmute

the microphone during a call using the Sounds menu. This feature is available only
during a call.

1 During a call, turn { to select Sounds from the Features menu,
then push .
The Sounds menu appears.

2 Push ( to select Mute/UnMute.
Now the microphone is muted.

3 To unmute the microphone, push .
The Sounds menu reappears.

4 Push & to select Mute/UnMute.

Now the microphone is unmuted.
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Adjusting the keybeep volume [F23]

You can adjust the volume of the beep that sounds when you press a button.

1 Turn @ to select Kesbeer Uol from the Sounds menu, then push .
The Keybeep Volume menu appears.

2 Turn @ up to raise the keybeep volume, and down to lower it.
You can select from four keybeep volume settings: of f, low, med. (medium),
and high.

3 Push ﬁ to enter the new setting.

Adjusting the earpiece volume [F24]
You can adjust the earpiece volume during a call by turning @ In addition, you
can adjust the volume as follows:

1 Turn @ to select Earriece Uol from the Sounds menu, then push ﬂ
The Earpiece Volume menu appears.

2 Turn @ up to raise the earpiece volume, and down to lower it.
There are seven earpiece volume settings ranging from | to 7. A higher
number indicates higher volume.

3 Push # to enter the new setting.

Setting the ringer type {F25]

You can set the type of beep that sounds for an incoming call.

1 Turn @ to select Ringer Tyre from the Sounds menu, then push ﬂ
The Ringer Type menu appears.

2 Turn @ to select the ringer type.
You can select from five different ringer settings. The ringer sounds every
time you turn @, if the ringer volume is not set to off or vibration.

3 Push K to enter the new setting.
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Setting the keybeep type [F26)

You can set the beep that sounds when you press a button to either a tone or a click.

1 Turn @ to select Key Sound from the Sounds menu, then push .
The Key Sound menu appears.

2 Turn @ to select the keybeep type.
You can select tones or clicks.

3 Push ﬁ to enter the new setting.

DTMEF tones are sent to the other party during a call even if you set the keybeep tvpe to
clicks.

Setting the keybeep length [F27]

You can set the length of the beep that sounds when you press a button. This setting
affects both the keybeep feedback and DTMF transmission tones. The standard
setting allows you to send a short tone each time you press a key. The long setting
allows you to send a tone for up to 15 seconds, as long as a key is held down.

1 Turn @ to select Beer Lenath from the Sounds menu, then push .
The Beep Length menu appears.

2 Turn @ to select the keybeep length.
You can select standard or 1ong.

3 Push #f to enter the new setting.
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Using the timers (Timers)

You can check call durations on the Timers menu. In addition, you can set the phon
to alert you every minute of a call, and make the phone turn itself off automatically.

Checking the duration of all calls [F31]

You can view the total duration of all calls. This information cannot be reset.

1 Turn @ to select A1 Calls from the Timers menu, then push #7.
The All Calls display appears.

2 push i to go back to the standby display.

Checking and resetting the duration of recent calls [F32]
You can view the total duration of the most recent calls.

1 Turn { to select Recent Calls from the Timers menuy, then push ¥
The Recent Calls display appears.

2 Press to reset, or hold down to go back to the standby
display.
If you choose to reset, the counter of recent calls and the corresponding
durations are reset.

Checking and resetting the duration of roam calls [F33]
You can view the total duration of the most recent roam calls.

1 Turn @ to select Roam Calls from the Timers menu, then push ﬁ
The Roam Calls display appears.

2 Press @ to reset, or hold down to go back to the standby
display.
If you choose to reset, the counter of recent roam calls and the
corresponding durations are reset.
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Setting the minute alert [F34]
You can set the phone to alert you ten seconds before every full minute during a call.

1 Turn @ to select Minute Alert from the Timers menu, then push 7.

The Minute Alert menu appears.
2 Tuin { to select on or of f.
3 Push & to enter the new setting.

Setting the phone to automatically turn off [F35]
You can set the phone to automatically turn itself off after a specified duration.

1 Turn @ to select Auto—Off from the Timers menu, then push ﬁ
The Auto-Off menu appears.

2 Turn @ to select the duration before the phone powers off
automatically.
You can select from never, in 3hours, in 2 hours, in 1 hour, and
in 30 mins. If you select never, the phone does not turn itself off
automatically.

3 Push  to enter the new setting.
A confirmation message appears.

* If you press any button or operate the Jog Dial navigator, the timer is reset and the
countdown starts over.

« The phone does not turn itself off automatically during a call.

« if the Auto-Off timer is set, the phone turns off after a user-specified duration and the
countdown Off 1xx xx:xx is displayed.

« Once the phone turns off, the setting will revert to never.
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Using the Directory (Directory)

You can use the Directory menu to check your phone number, as well as store, erase
and edit phone numbers and names in the Phone Book. Also, you can use this menu
to view the Calls List.

Checking your phone number [F41]

1 Push #] to select My Number from the Directory menu.
The My Phone # display appears, showing your phone’s number.

2 Push i to exit this feature.

Storing phone numbers [F42]

For quick and easy dialing, the Phone Book allows you to store up to 99 phone
numbers.

For information about using the Save feature of the Directory menu, see “Storing
phone numbers in the Phone Book (Save)” on page 4.1.

Erasing a phone number [F43]

You can erase stored Phone Book entries. If the selected entry is restricted, you mus
enter the four-digit lock code to erase it (see page 5.16).

For information about using the Erase feature of the Directory menu, see “Erasing -
phone number (Erase)” on page 4.4.

Editing stored information [F44]

You can edit the name, phone number, and memory location of specific entries
stored in the Phone Book. If the selected entry is restricted, you must enter the fous
digit lock code to edit it (see page 5.16).

For information about using the Edit feature of the Directory menu, see “Editing
stored information (Edit)” on page 4.3.

Searching the Phone Book by name [F45]

You can find name entries in the Phone Book by searching alphabetically or for a
string of characters.

For information about the Find Name feature of the Directory menu, see “Searchir
for a name (Find Name)” on page 4.8.
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Searching the Phone Book by memory location [F46]
You can view Phone Book entries easily.

1 Turn @ to select Phone Book from the Directory menu, then push ﬂ

2 Turn @ to scroll through the Phone Book entries, or use the
number buttons to enter the memory location number.

Tip
You can also use the Options menu to find Phone Book memory locations (see page 4.9).

Viewing the Calls List [F47]

You can view Calls List entries easily.

1 Turn @ to select CallsList from the Directory menu, then push .
If the Calls List is empty, the display shows the message
CallslList isemrty,

2 Turn {{ to view the Calls List entries.
The most recent entry is displayed first. To view the rest of the ten most

recent entries, turn @

Tip
You can also view the Calls List from the standby display (see page 4.10).
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Using extra features (Extras)

On the Extras menu, you can set the phone to enable touch dialing, redial
automatically, and answer incoming calls automatically or at the press of any button.
Also, you can use this menu to lock the keypad and to jot down phone numbers.

Preventing accidental operation [F51] ,
When the microphone arm is closed, you can lock the keypad by pushing and holding
ﬁ from the standby display. You can also lock the keypad from the Features menu,
as described below. Locking the keypad offers low-level security. For example, it
prevents accidental dialing if you keep the phone in your pocket or purse.

1 Turn @ to select Key Guard from the Extras menu.
The Key Guard menu appears.

2 push if.
A message appears, confirming that the keypad is locked. The keypad lock
icon (@) and the text Kesguard On indicates that the keypad is locked.

To unlock the keypad

1 Press @, @ and in quick succession.

To unlock the keypad temporarily

1 Open the microphone arm.
The keypad becomes unlocked.

2 Close the microphone arm.
The keypad is locked again.

To answer an incoming call when the keypad is locked
Open the microphone arm to temporarily unlock the keypad.
Tips

* Keybeeps are turned off when the keypad is locked.
* Press and hold ﬂ to turn on the backlight temporarily when the keypad is locked.

Activating touch dialing [F52]
if you want to use the touch dialing feature (see page 4.7), set to ON.

1 Turn { to select TouchDial from the Extras menu, then push .
The Touch Dial menu appears.

2 Turn & to select on or of f.
3 Push & to enter the new setting.
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Setting the phone to redial automatically [F53]
You can set your phone to redial a number automatically. If the attempt to dial is not
successful, the phone tries to redial it up to five times every three seconds.

1 Turn { to select Auto—Retry from the Extras menu, then push & .
The Auto-Retry menu appears.

2 Turn { to select on or of f.
If you select off, the phone does not try to redial automatically.

3 Push §] to enter the new setting.

Setting the phone to answer automatically [F54]

You can set the phone to answer calls automatically. If you turn auto-answering on,

the phone answers incoming calls on the second ring when the phone is used with a

hands-free car kit or a portable hands-free car kit. See “Accessories” on page 6.2 for

more information about accessories you can use with your phone.

1 Turn @ to select Auto—Answer from the Extras menu, then push .
The Auto-Answer menu appears.

2 Turn { to select on or of f.

3 Push ﬁ to enter the new setting.
The message ~Autofnswer— is displayed on the standby display when you
select on and the phone is in the hands-free car kit.

Using the scratch pad [F55]

Your phone has a scratch pad feature, which is useful for writing down phone
numbers temporarily. The phone doesn’t send DTMF tones when you enter digits to
the scratch pad.

1 Turn @ to select Scratch Pad from the Extras menu, then push .
_ The Scratch Pad display appears, asking you to enter a phone number.
2 Use the number buttons to enter the digits.

3 push .
The Options menu appears. Besides storing digits, you can enter hyphens,
pauses, and links (see page 4.2).

4 Turn { to select StoretExit, then push .

The information is stored as a scratch pad entry in the Calls List.
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Setting security options (Security)

You can restrict unauthorized access to your phone and the information it holds.
Also, on the Security menu, you can reset menu settings to default and store
emergency numbers. Unlike other items on the Features menu, accessing the
Security menu requires a lock code when you select it from the menu.

A typical default lock code is either the last four digits of your phone number or 0000.

Preventing others from using your phone [F61]
This option lets you set when the phone will be locked. When the phone is locked,
carrying out most operations requires entering the lock code; you can still answer
incoming calls and dial 911 or other stored emergency numbers.
1 Push i to select Lock Phone from the Security menu.

The Lock Phone menu appears.

2 Turn @ to select when the phone will be locked.
You can select never, on Power-up, or right now. If you select never, the
phone is available for use at any time without a lock code. If you select
on Power-up, the phone is locked every time you turn it on.

3 Push # to enter the new setting.
The message 3 :Unlock indicates that the phone is locked.

To unlock the phone
On the standby display, push ﬁ When prompted, enter the lock code.

Setting a new lock code {F62]
The lock code must be entered every time you want to unlock the phone, and also
when you want to access restricted numbers.

1 Turn @ to select New Code from the Security menu, then push ﬁ
The Enter New Code display appears, asking you to enter a new lock code.

2 Use the number buttons to enter a lock code.
The lock code must be exactly four digits long.

3 Push i to store the new lock code in memory.
A confirmation display appears.

Keep a record of your lock code. If you forget it, contact your service provider.
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Restricting a Phone Book entry [F63]

You can restrict access to individual Phone Book entries.

For information about using the Restrict It feature of the Security menu, see
“Restricting Phone Book entries (Restrict)” on page 4.4.

Restricting all Phone Book entries [F64]
You can restrict access to all Phone Book entries. All operations that involve Phone
Book entries require the four-digit lock code (see page 5.16).

1 Turn @ to select Restrict All from the Security menu, then push ﬁ'
The Restrict All menu appears.

2 Turn @ to set restriction of all Phone Book entries on or off.

3 Push ] to enter the new setting.

If you restricted some entries by using Restrict #, they are still restricted when you turn
off RestrictAll.

Reverting to default settings {F65]
You can reset all menu settings to the original factory settings. This does not affect
Phone Book or Calls List entries.

1 Turn @ to select Master Reset from the Security menu, then push .
The Master Reset display appears.

2 Press @D to reset to the original factory defaults, or push  to
keep the current settings.
If you reset to the factory defaults, all your custom menu settings are erased.

Erasing all Phone Book entries [F66]
-You can erase all Phone Book entries at once.

1 Turn @ to select Erase Book from the Security menu, then push .
The Erase Book display appears.

2 Press @ to erase all Phone Book entries, or push ﬁ to quit without
erasing.
If you erase all entries, a message appears to confirm this.
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Erasing all Calls List entries [F67]
You can erase all Calls List entries at once.

1 Turn @ to select Erase Calls from the Security menu, then push ﬂ
The Erase Calls display appears.

2 Press to erase all Calls List entries, or push ﬂ to quit without
erasing.
If you erase all entries, a message appears to confirm this.

Storing emergency numbers [F68]

You can use the Security menu to store up to three emergency numbers other than
911 (which you cannot erase). You can call these numbers even when the phone is
locked.

1 Turn @ to select Emergency § from the Security menu, then push ﬂ
The first Emergency # display appears.

2 Turn @ to select the emergency memory location, then push ﬂ
A message appears, asking you to enter the phone number for the
emergency entry.

3 Use the number buttons to enter the number.

4 Push ﬂ to store the emergency number.
The entered emergency number is stored in memory. To store other
emergency numbers, repeat the above procedure.
To go back to the standby display, hold down G&B.
Tip
You can store your emergency numbers in both the emergency number memory and the
Phone Book. You can then use speed dialing or touch dialing to dial your emergency
numbers.
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Setting display options (Display)
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You can use the features on the Display menu to change the appearance of the on-
screen display.

Setting the banner [F71]
You can change what the banner reads.

1 Push ﬁ to select Banner from the Display menu.
The Banner display appears. The current banner text is displayed.

2 push & again to start editing.
A message appears, asking you to enter a new banner.

3 Use the number buttons and &/@&> or @ to enter the new banner
text.
The banner can be up to 12 characters long. For details on character entry,
see the “Alphanumeric table” on page 4.2.

4 push § to save the new banner.
Your new banner is displayed.

Setting the backlight [F72]
You can adjust the duration of the backlight on the display and keypad.

1 Turn @ to select Backlisht from the Display menu, then push .
The Backlight menu appears.

2 Turn @ to select how long the backlight is on after the last press
of a button.
You can select from several time periods; the backlight will remain on for
the set duration. If the phone is used with a hands-free car kit or a charging
accessory, the added option of @always on leaves the backlight on.

3 Push i to enter the new setting.
.Tip
Your phone has two backlight settings: one in charging mode and one in battery mode.

The factory setting for charging mode is alwaus on. For faster charging, you may want to
change the setting.
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Setting autohyphenation [F73]

You can turn the autohyphenation feature on and off. If you turn it on, entered
numbers are hyphenated according to the US/ Canada standard (eleven digits which
include a long distance identifier, an area code, a three-digit community code, and a
four-digit location code, for example, 1-800-555-1212).

1 Turn @ to select Auto-Huphen from the Display menu, then push ﬁ
The Auto-Hyphen menu appears.

2 Turn { to select on or off.
3 Push ﬁ to enter the new setting.

Autohyphenation is not fully deactivated when a pause or link is entered. All entered
hyphens up to the pause/link will remain.

Sorting the Phone Book [F74]
You can determine how the Phone Book will be displayed, and also set the phone to
sort the entries either alphabetically or by memory location.

1 Turn @ to select Sort Book from the Display menu, then push ﬁ
The Sort Book menu appears.

2 Turn @ to set the sorting preferences.
You can choose to sort the Phone Book by Loc . 1t (by location) or
alphabetic (alphabetically).

3 Push i to enter the new setting.

Selecting the language [F75]
You can change the language used on the displays.

1 Turn @ to select Language from the Display menu, then push ﬁ .
The Languages menu appears.

2 Turn @ to select the language.
English, Spanish, French and /or Portusuese may be available,
depending on your area.

3 Push & to enter the new setting.
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Setting the menu length [F76]
You can set the menu length (long or short). The short menu displays only the most
common items on the Features menu; the long menu displays all items.

1 Turn @ to select Menu Length from the Display menu, then push ﬂ
The Menu Length menu appears.

2 Turn { to set the menu length.
You can select short or long.

3 Push & to enter the new setting.

Items on the short menu

The short menu contains the following items:
» Messase (see page 5.2)

» Ringer Uol. (see page 5.7)

« MyNumber (see page 5.12)

* Saved fis (see pages 4.6, 4.8, 4.10)

* Lock Phone (see page 5.16)

* Long Menu (see page 6.5)

The item Saved s contains the items Find Name (see page 4.8), Phone Book (see page 4.1),
and Calls List (see page 4.10).

To return to the long menu
On the short menu, turn @ to select Long Menu, then push # .

Setting the message format [F77]

You can choose formats that determine how your phone displays incoming messages.
If you select none, the message is displayed exactly as it was received. If you select
partial, lines with more than 12 characters are wrapped. If you select full,
consecutive whitespace characters (such as double spaces) and carriage returns are
replaced with a single space.

"1 Turn @ to select Msg. Format from the Display menu, then push ﬁ
The Message Format menu appears.

2 Turn { to set the message format.
You can select none, Ppartial or full.

3 Push i to enter the new setting.
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Adjusting network settings (Network)

The Network menu allows you to set how your phone interacts with the cellular
network. You can set the phone to alert you when the roaming status changes, when
a call is dropped, or when enhanced voice privacy is gained or lost. You can also set
how NAM'’s (Number Assignment Modules) are switched, set system priorities or
set the phone to operate in analog mode.

Setting the roaming alert [F81]
Your phone is roaming when you use it outside of the home area. Roaming access to
a different carrier and the types of calls you can make varies with the agreement
between your “home” carrier and the currently serving carrier. Check with your
service provider for details about-roaming in a specific area.
1 push #f to select Roam Alert from the Network menu.

The Roam Alert menu appears.

2 Turn @ to select on or off.
3 Push ﬁ to enter the new setting.

When you enter another service area
The roaming icon ([ appears on the display. A beep accompanies the icon if you
have turned the roam alert on.

If you leave any valid service area

A message appears, indicating that you are outside the area serviced by your
“home” carrier or other valid service areas. The out-of-service icon () also appears,
and a beep accompanies the icon if you have turned the roam alert on.

Setting the drop alert [F82]
If the signal fades, your phone may drop the ongoing call. You can choose to be
alerted by an audible alarm when a call is dropped.

1 Turn @ to select Droe Alert from the Network menu, then push ﬁ
The Drop Alert menu appears.

2 Turn @ to select on or of f.
3 Push i to enter the new setting.

When a call is dropped
A beep accompanies the icon if you have turned the drop alert on.
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Setting the voice privacy alert [F83]

Some networks and service providers offer the feature of enhanced voice privacy.
This feature encrypts transmissions to and from your phone for added privacy. A
display appears to indicate if enhanced voice privacy is lost or gained during a call.
You can choose to have an audible alarm accompany this display.

1 Turn @ to select Priv. Alert from the Network menu, then push ﬁ
The Priv. Alert menu appears.

2 Turn @ to select on or off.
3 push  to enter the new setting.

If enhanced voice privacy is lost
A message appears, and is accompanied by a beep if you have turned on the voice
privacy alert.

When enhanced voice privacy is regained
A message appears, and is accompanied by a beep when enhanced voice privacy is
regained and you have turned on the voice privacy alert.

The network automatically turns on enhanced voice privacy if it is available. You do not
have to change your phone settings. For details, contact your service provider.

Switching NAM's automatically [F84]

Your phone allows you to store up to two NAM’s (Number Assignment Modules).
To add or remove NAM's, contact your service provider who will change the
NAM's for you. You can set the phone to switch between them automatically. The
phone switches from one NAM to the other if it enters a service provider’s coverage
area that matches one of your NAM settings. To switch manually, see “Switching
NAM’s manually” on page 5.24.

1 Turn @ to select Auto—N.A.M. from the Network menu, then push ﬁ
The Auto-N.A.M. menu appears.

2 Turn @ to set automatic switching on or off.

3 Push & to enter the new setting.
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Switching NAM’s manually [F85]

If automatic switching is turned off, you can configure the phone for manual
switching between the two NAM's. You must switch from one NAM to the other if
the phone enters a service provider’s coverage area that matches the other NAM
setting. To set the phone to switch automatically, see “Switching NAM’s
automatically” on page 5.23.

1 Turn @ to select Set-N.A.M. from the Network menu, then push ﬁ
The Set-N.A.M. menu appears.

2 Turn @ to switch between the two NAM's,
The display alternately shows the name and the number of the selected NAM.

3 Push ] to enter the new setting.

selecting system priority [F86]

If you leave the service area of a carrier from which the phone is currently receiving
signals, the phone automatically starts searching for another carrier. You can control
the order in which the phone searches for a carrier.

If you select standard, the phone searches for the system to which you subscribe
first, then searches for an alternate system. If you select home side, the phone
searches for the system to which you subscribe in ail regions of coverage. If you
select roam side, the phone searches only for an alternate system. If you select

home onls, the phone searches for the system to which you subscribe only in your
home region.

1 Turn @ to select Set Sustem from the Network menu, then push ﬁ
The Set System menu appears.

2 Turn @ to set the preferences.
You can select standard, home side, roam side, or home only.

3 Push ﬁ to enter the new setting.
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Forcing the phone into analog mode [F87]
You can force the phone into analog mode for the next outgoing or incoming call.

1 Turn @ to select Force Call from the Network menu, then push .
The Force Call menu appears.

2 Press to force the phone into analog mode, or push ﬁ to stay in
digital mode.
Your phone stays in analog mode for 10 minutes, or until you terminate the
call or turn off the phone.

Your phone generally stays in digital mode as long as digital service signals are received.
The phone switches to analog mode when an analog service but no digital service is
available, even if you do not perform the procedure above.
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Troubleshooting

-
Problem Cause/Remedy Page
Nothing appears on the ¢ The phone is off. Turn the phone on. 31
display. ¢ Battery is fully discharged. Recharge the battery. 2.5
The out-of-service icon @) » The phone is outside the service area, or the 3.1
appears. signal is too weak. Extend the antenna fully.
Nothing happens when you ¢ The buttons may be locked. 5.14
press the buttons. ¢ The phone may be locked. Enter the lock codeta 516
unlock the phone.
The call does not go through. e Check the signal strength. 3.1
¢ If the & icon is displayed, there is no service. 31
See above.
¢ Check the number. 32
® Press (580). 3
¢ Listen for a busy signal.
You can hear the other party, ¢ The microphone may be muted. Unmute the 32,
but the other party cannot microphone. 5.7
hear you.
You hear the other party ¢ Adjust the earpiece volume. If possible, also 3.2,
only faintly. reduce the noise around you. 5.8
The call is cut off * You could be outside the coverage area. Redial 3.1

(“dropped”).

the number. If the problem continues, contact
your carrier. Also see “The out-of-service icon (I€)
appears” above.

You hear an alternate high/
low tone.

You are attempting to use the phone in an area
without service.

Extend the antenna fully.

Let the & icon disappear, then try to dial.

. You forgot the lock code.

Try 0000 or the last four digits of your own
number.
See your service provider or authorized dealer.

You hear a fast busy tone.

This can result from any one of the following:
~ The phone is improperly programmed.

- The phone is out of range.

- All channels are busy.

~ The antenna is broken or damaged.

—
|2

w

You cannot place or receive
calls.

Make sure that the phone is turned on, and that
the out-of-service icon is not displayed.

Check the system settings.

If you are roaming, consult your service provider
concerning roaming agreements.

-
o

o
2
13

6.1

Additional Information



Accessories

Supplied accessories
Additional accessories and different AC adapters may be supplied with phones
outside North America.

QN-029BPL Li-lon Battery
QN-001AC AC Adapter
Hand strap

QN-021BCD Dual Slot Battery Charger
The Dual Slot Battery Charger may be supplied with phones outside North America.

Using the QN-021BCD Dual Slot Battery Charger
Before using the Dual Slot Battery Charger, please
read these instructions thoroughly. This Dual Slot 1
Battery Charger is for the QN-029BPL Li-lon
Battery.

The front slot is for rapid charging and the rear slot
is for standard charging. The two slots can be used
separately or at the same time. See “Charging the
Battery” on page 2.5 for more information about
charging your battery.

CAUTION
Use only the supplied AC Adapter with the QN-
021BCD Dual Slot Battery Charger.

Charging the batteries

1 Insert the DC plug of the adapter into
the battery charger. Plug the AC adapter
into an AC outlet.

2 To charge a battery connected to the

phone, insert the telephone into the
front slot of the charger. 3
The charging status is indicated on the
display of the phone.

3 To charge a spare battery, insert it into
the rear slot.
The charge lamp lights up red. When the
lamp turns green, charging is complete.
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Optional accessories

QN-008CLA Rapid
Charging Cigarette
 Lighter Adapter

QN-021BCD Dual Slot
Battery Charger

L]}

QN-026HS Phone
Holster

QN-009TA Travel
Adapter

QN-023DCS Desktop
Charger Speakerphone

QN-027LC Carrying
Case

QN-012DAS
FoneBook™ PLUS
Software with
Interface Cable

QN-024HC Auto Travel
Holder

QN-020TCL
Combination Travel
Adapter/Cigarette
Lighter Adapter

QN-025PHK Portable
Hands-Free Car Kit

QN-029BPL Li-lon
Battery Pack

{/

QN-030HFK Hands-
Free Car Kit

Call 1-800-488-SONY (7669) to order additional accessories (USA only).

* All accessories may not be available at press time.
¢ Some accessories may not be available outside the United States.
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Specifications

Frequency range
Transmit: 824 to 849 MHz
Receive: 869 to 894 MHz

Dimensions
3.6 x 2.4 x 1.0 inches (h/w/d)
(not including antenna)
(91 x 62 x 26 mm)

Mass (weight)
Approx. 5.4 0z (152 g)
(including battery)

RF power output
CDMA mode: 0.01 pyW to 200 mW
AMPS mode: 6 mW to 600 mW

Operational temperatures
Phone
-22°F to 140°F (-30°C to 60°C)
Battery (operating temperature)
—4°F to 140°F (-20°C to 60°C)
Battery (charging temperature)
32°F to 104°F (0°C to 40°C)

Design and specifications are subject to change without notice.
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List of menu items

BT

This section lists the Features menu and its submenus. You can use the Features

menu to activate the special features of your phone.

Menu item Settings Page
F11 Voice* — 5.3
F12 New Text* — 5.4
F13 Old Text* — 5.4
F14 Erase Old* — 5.6
F21 Ringer Vol. off / low / medium /high / escalate / vibration 5.7
F22 Mute/UnMute mutes or unmutes the microphone 5.7
F23 Keybeep Vol off / low / medium / high 5.8
F24 Earpiece Vol 1/2/3/4/5/6/7 5.8
F25 Ringer Type standard / option 1 to 4 5.8
F26 Key Sound tones / clicks 5.9
F27 Beep Length standard / long 5.9
F31 All Calls total call time, number of calls 5.10
F32 Recent Calls total call time, number of calls 5.10
F33 Roam Calis* total call time, number of calls 5.10
F34 Minute Alert off / before min. / each min. / every 5 min 5.11
F35 Auto-Off never / in 3 hours / in 2 hours / in 1 hour / in 30 mins 5.11
F41 My Number — 5.12
F42 Save — 5.12
F43 Erase — 5.12
F44 Edit — 5.12
F45 Find Name — 5.12
F46 Phone Book No default entries 5.13
F47 Calls List No default entries 5.13
F51 Key Guard — 5.14
F52 Touch Dial on / off 5.14
F53 Auto-Retry on / off 5.15
F54 Auto-Answer on / off 5.15
F55 Scratch Pad — 5.15
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Menu Item Settings Page
F61 Lock Phone never / on power-up / right now 5.16
F62 New Code 0000 5.16
F63 Restrict # No default numbers 5.17
F64 Restrict All on / off 5.17
F65 Master Reset — 5.17
F66 Erase Book — 5.17
" F67 Erase Calls — 5.18

F68 Emergency # No defaults for #1 to #3 5.18
F71 Banner No default banner 5.19
F72 Backlight off / for 7 secs / for 15 secs / always on (available

when used with charging accessories) 519
F73 Auto-hyphen on / off 5.20
F74 Sort Book by loc. # / alphabetic 520
F75 Language** English / French / Spanish / Portuguese 5.20
F76 Menu Length long / short 5.21
F77 Msg. Format* none / partial / full 5.21
F81 Roam Alert on / off 5.22
F82 Drop Alert on / off 5.22
F83 Priv. Alert** on / off 5.23
F84 Auto-N.A.M.* on / off 5.23
F85 Set-N.A.M.* set-N.AM. #1 / set-N.A.M. #2 524
F86 Set System* standard / home side / roam side / home only 5.24
F87 Force Call* — 5.25

*) These features may be available in some areas and with some service providers.
Check with your service provider to see if these features are available in your area.
**) These features may not be fully available in some countries.
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Glossary

A

Automatic answer
Feature that automatically answers calls.

Automatic retry

Feature that automatically redials a call
when a “System Busy” indication is -
received.

B
Banner
Message at the top of the standby display.

C
Calls List
See “Phone Book.”

Carrier
A company that provides cellular
telephone service.

CDMA
Code Division Multiple Access. A spread-

spectrum approach to digital transmission.

With CDMA, each conversation is
digitized, and then tagged with a code.
The mobile phone receives only the signal
with the appropriate code.

Coverage area

The geographic area covered by one
carrier. If you travel outside a carrier’s
area, you cannot receive service from that
carrier. Also see “Roam.”

D

Dropped call

A call terminated because of a deep, long
fade or because the user left the coverage
area. . -

DTMF

Dual Tone Multiple Frequency, also
known as “touch-tone.” Tone generated
when you press a telephone button
(number, *, or #). Can be used to access
answering machines, pagers, telephone
banking services, data services, and other
electronic services.

E

ESN

Electronic Serial Number. The unique
identification number of your telephone.
The telephone transmits this number to
the base station every time a call is placed.

Emergency number

In addition to the general emergency
number (911 for the U.S.A. and Canada),
three phone numbers can be stored as
emergency numbers in your telephone.
You can dial these numbers and 911 even
when the phone is locked.

H

Home area

The area of the home system to which you
subscribe.

|
Incoming call
A call received by your telephone.

L

Lock

Prevents unauthorized calls by requiring
the user to enter a code to use the phone.
Even if the phone is locked, you can cali
any of the emergency numbers or answer
incoming. calls.

M

Memory .

A storage area for names and phone
numbers. Also see “Phone Book.”

Menu

The menu allows you to change or see the
settings of your phone. You can access it
from the standby display or during a call.
See “List of menu items” on page 6.5 for
an overview of this feature.

Minute alert

This alert beeps periodically during a call
to help vou keep track of the length of the
call.
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N

NAM

Number Assignment Module. Portion of
your telephone’s memory programmed to
contain information about your
subscription to the carrier. Your telephone
can have up to two NAM's.

P

Pause

You can enter pause codes in the phone
number memory data. Use this feature
when accessing an answering machine,
voice mail system, electronic banking
system, etc. When a pause is inserted
between two groups of digits, the phone
will pause before dialing the next set of
digits, allowing you to wait until your
counterpart is ready to accept the string.

Phone Book

You can store up to 99 numbers in Phone
Book memory, location number 01 to
number 99. An additional recent number
memory (Calls List) stores the last ten used
phone numbers.

R

Roam

Your phone is roaming when you use it
outside of the home area. Availability of
roaming access to a different carrier and
types of calls you can make varies with the
agreement between your home carrier and
serving carrier. Check with your carrier for
details about roaming in a specific area.

6.8

S

Scratch pad

Allows you to enter a number and store it
in the Calls List.

Service area
Region covered by a cellular service. Also
see “Coverage area.”

SMS

Short Messaging Service. An extended
service offered by carriers that allows you
to receive text messages on your phone.
Check with your carrier for details.

Speed dialing
Making a call using Phone Book memory
locations. Also see “Phone Book.”

T
Touch dialing

A quick way of making a call using a
number stored in a Phone Book memory
location. Also see “Speed dialing.”

Touch-tone
See “DTMEFE.”

A

Voice mail

An extended service, offered by carriers,
that allows you to retrieve voice mail
messages stored in your voice mailbox.
Check with your carrier for details.

Volume
You can adjust the volume of keybeep,
ringer, and earpiece.
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Hand strap

Attaching 2.1
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Rules and regulations 1.6
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Making calls 3.2
Manual
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Microphone 3.2,5.7
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Quitting. See Power
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Receiving

Calls 33
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Voice mail 5.3
Recent Calls [F32] 5.10
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Clearing call memory 5.18
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System settings
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T
Text Message. See Messages
Touch Dial [F52] 5.14
Troubleshooting 6.1
Turning phoneon 3.1
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Vibration alert 5.7
Voice [F11] 5.3
Voice mail notification
Accessing 5.3
Receiving 53
Voice Privacy 5.23
Volume

Adjusting 5.7

6.11

Additional information



SONY Wireless Hotline Number
(USA only)

If you have any questions or comments,
please call:
SONY WIRELESS HOTLINE
1-800-578-SONY (7669)

You can also visit the
SONY WIRELESS WEBSITE at
www.sony.com/wireless
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